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 Lab 01 : Getting S tarted with SharePoint 2010  

Lab Time: 45 minutes 

Lab Folder: C:\Student\Labs\01_Roadmap 

Lab Overview: In this lab you will begin your work with SharePoint 2010 and become familiar with the Virtual Machine (VM) that 
you will be using in this weekôs SharePoint 2010 Developer Workshop. You will get experience working with the SharePoint Central 
Administration site as well as working with a standard team site. This will allow you to experience the new user interface concepts 
introduced in SharePoint 2010 such as the server-side ribbon and in-place item editing. You will also get a chance to write and test 
C# code using the WSS ó14ô object model. Note that we are purposefully delaying any work with the new VS10 Tools for 
SharePoint 2010 until the next lab because this new tool set is the focus of the next lecture. At the end of this lab you will also get 
some hands-on experience working with PowerShell and the new SharePoint 2010 PowerShell Snap-in. 

Note about Using Beta Software: The VM for this SharePoint 2010 Developer workshop has been built using a 64-bit version of 
Windows Server 2008 and the Beta1 version of Microsoft SharePoint Server 2010. Beta 1 version of Visual Studio 2010 with the 
new SharePoint 2010 developer tools and the Beta1 version of Microsoft Office client application including SharePoint Designer 
2010 are also installed on the VM. While working with beta software gives you a great opportunity to get an early look at the 
product, you must also understand that many aspects of the user interface are not complete and you will likely encounter bugs and 
areas of various products where functionality has not yet been enabled. 

Lab Setup Requirements  

¶ Before you begin this lab, you must run the batch file named SetupLab01.bat. When you run this batch file, it executes a PowerShell script that 

creates a new SharePoint site collection at the location http://moss.contoso.com/sites/Lab01. 

Exercise 1: Creating a Site Collection  in SharePoint  Central Administration  

In this exercise you will create a new SharePoint site collection using the SharePoint Central Administration site. 

1.  Make sure you are logged into the VM as the local administrator with a user name of 
Contoso\Administrator and a passw ord of pass@word1. 

2.  Navigate to the SharePoint 4.0 Central Administration site. You can do this using the shortcut inside the 

Administrative Tools menu of the Windows  Start menu. On this VM you can also get to the SharePoint 

4.0 Central Administration site by opening the browser and navigating to the following URL:  

http://moss:6147/default.aspx  

3.  Explore the various pages of the Central Admin site by clicking the links in the Quick Launch bar 
such as Application Management, System Systems and Monitoring. This should give you an idea of how 
the Central Administration site breaks up management tasks into different functional areas.  

4.  Click on the Application Management link in the Quick Launch bar to navigate to the Application 

Management page. Inside the Site Collections section of this page, you should see several links for 
creating and managing site collections. Click in the link titled View all Site Collections which takes you 

a page which shows you the site collections currently existing on the Web Application at 
http://moss.contoso.com. By clicking on the individual site collections on the left, you should be able 

to view information about each site collection on the right of the page. You should observe that 
the VM has a fe w existing site collections in this Web Application.  

5.  Now it is time to create a new site collection. Click on the Application Management link in the Quick 

Launch bar and then click on the link in the Site Collections section titled Create Site Collections. Once 

you have done this you should be at a page that allows you to enter information for creating a 
new site collection. Enter the following information so that your screen looks like the screenshot 
shown below and then click OK to begin the provisioning process to create a new site collection.  

a)  Title : Contoso Sales Site  

b)  Description : My first SharePoint 2010 site collection  

c)  Url : http:// moss.contoso.com /sites/Lab01A  

d)  Template : Team site (this template is in th e Collaboration tab)  

e)  Primary Site Collection Administrator User Name : CONTOSO\ Administrator  

f)  Secondary Site Collection Administrator User Name : (leave blank)  

http://wingtipserver/
http://wingtipserver/sites/Lab01A
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g)  Quota Template : No Template  

 

6.  After the site collection provision process is complete, you should a  page as the one shown below. 
Click on the provided link to navigate to new site.  

 

7.  When you see the newly -provisioned site collection with a Team site as its top - level site, move on 
to the next exercise.  

 

In this exercise you learned how to create a SharePoint site collection using the SharePoint Central Administration 
site. 
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Exercise 2: Working with the SharePoint 2010 Ribbon and In -place Editing  

In this exercise, you will complete work inside the top-level site of the site collection you created in the previous 
exercise at http://moss.contoso.com/sites/Lab01A. You will begin by adding and viewing items inside of some of the 
lists that are automatically created as part of a new Team site so you can experience the new paradigm for in-place 
editing. After that, you will work with a Web Part Page so you can experience how the SharePoint 2010 user 
interface has changed the way users manage Web Parts. 

1.  At this point you should be at the home page of the site creat ed in the previous exercise at the 
URL http://moss.contoso.com/sites/Lab01A/SitePages/Home.aspx. Note that the home page is not 

default.aspx  but rather a wiki page named Home.aspx  located inside a wiki page library named 
SitePages. 

2.  Observe that the page Home.aspx  already contains some generic content including large text block 

at the top of the page which reads "Welcome!". Go into edit mode for the wiki page by clicking 
the Edit Page m enu within the Site Actions menu. Once in edit mode, change the entire section of 

text that begins with "Welcomeé" to "Contoso Sales Site". Use the font toolbar buttons in the ribbon 

to give your new text a font with a size and a color to your liking.  

3.  Whil e still in edit mode, delete the graphic of the generic stock photo that has been placed on the 
right -hand side of the page. Now itôs time to add a different photo. Place you cursor on the page 
at the position where the old photo used to be. Inside the rib bon, select the Insert tab from the 
Edit Tools contextual ribbon tab. Click on the Image button to add a new picture to the page which 
should bring up the Add Picture dialog shown below.  

 

Note that the Add Picture dialog will allow to select a graphic ima ge which will be automatically 
uploaded and stored in a special document library named Site Asset Library. Click the Browse 
button of the Add Picture dialog and navigate to and select the image at the following URL.  

C: \ Student \ Labs \ 01_Roadmap\ StarterFiles \ JayHenningsen.jpg  

 

4.  Now that you have made some cosmetic changes to the home page, save your changes by 
selecting the Format Text tab in the Editing Tools tab group in the ribbon and select Stop Editing. 

http://wingtipserver/sites/Lab01A
http://moss.contoso.com/sites/Lab01A/SitePages/Home.aspx
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5.  Now it's time to explore some other parts of the new  site. Drop down the Site Actions menu and 

see what menu items are available. Click on the Site Actions menu titled Site Settings to navigate to 
Site Settings page. Inspect all the various links to the various administration pages that have been 
designed f or site collections owners and site administrators.  

6.  Click on the link on the Site Settings page in the Look and Feel section titled Title, description and 

appearance which takes you to a page where you can see the title and description you entered for 
the site in the previous exercise. Enter a new value for the Logo Url to assign the site a different 

site icon. You can use one of the following URLs which point to images that are part of the 
standard installation for SharePoint 2010.  

/_layouts/images/search. png  
/_layouts/images/unknownperson.png  
/_layouts/images/ gears_an.gif  

 

7.  Now it is time to add a new item to a list so you can experience working with the new server -side 
ribbon and in -place editing. Click on the Tasks link in the Lists section of the Quick Launch bar to 
navigate to the Tasks list which was created as part of every new Team site. You should observe 
that there are no existing task items in this list. You should also observe the Task list has an 
associated server -side ribbon with a set of tabs including Browse, Share & Track, Items and List. Click 

on each of these tabs to see how the ribbon changes to display a contextual set of controls for a 
given set of tasks.  

8.  Click on the Items tab of the Task list and then drop down the New Item menu and se lect Task. This 

action will display an input form for you to enter the data for a new task item and to click OK to 
save the new task item back to the content database. The next step will provide you with the 
data for the new task. At this point it is impor tant for you to observe that the new SharePoint 

2010 user interface experience is allowing you to add and edit tasks items without making the 
user endure HTTP post backs as was required in the previous version of SharePoint.  

 

9.  Create a new task using the f ollowing data.  
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Title : Learn  how to develop on SharePoint 2010  

Predecessors : none  

Priority : (1) High  

Status:  In Progress  

Complete : 2%  

Assigned To : Contoso \ Administrator  

Description : Find out how to develop useful solutions  

Start Date : 8/1 /2009  

Due  Date : 8/4 /2009  

10.  Create a second new task using the following data.  
Title : De velop Solutions on SharePoint 2010  

Predecessors : Learn  how to develop on SharePoint 2010  

Priority : (1) High  

Status : Not Started  

Complete : 0%  

Assigned To : Contoso \ Administrator  

Description : B egin devel oping solutions on SharePoint 2010  

Start Date : 8/5 /2009  

Due  Date : leave blank  

11.  Once you have entered in the two tasks from the previous steps, experiment with the list view if 
items in the task list by hovering over individual items. Note that eac h item highlights as you 

hover over it and the UI gives you the ability to select it. Use the ECB menu (the standard 
SharePoint item -hover menu) to go into edit mode for one of the tasks you have created as 
shown below. Make a simple edit to the task and s ave it to observe the in -place editing behavior.  

 

12.  Now it is time to add a Web Part to a Web Part Page using the new UI experience for managing 
Web Parts. Navigate to the page default.aspx which is located at the root of the site. Note the built -

in navigat ion scheme does not have a link to this page in a new team site so you should type the 
following URL into the browsers address bar: http://moss.contoso.com/sites/Lab01A/default.aspx. 

13.  Note that the ribbon on this page like any other Web Part page has three tabs titled Browse, Share 

& Track and Edit. Click on each of these tabs and see how the contextual controls on the ribbon 

change for each of these tabs. Click on the Edit tab and then select th e Edit Page button that takes 
you into the mode for adding, modifying and deleting Web Parts from the page.  

http://wingtipserver/sites/Lab01A/default.aspx
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14.  Delete the two existing Web Parts ( Announcements and Calendar) in the Left Web Part Zone by 

clicking on the Delete command inside their Web Part m enu.  

 

15.  Now that you have deleted those two Web Parts from the Left Web Part Zone, it is time to add a 
new Web Part to display the tasks inside the Tasks list. First, make sure the Left Web Part zone is 
selected (selected Web Part zones are indicated with a  dotted border) so that contextual Page 

Tools ribbon tab is displayed. Click on the Insert tab on the ribbon and click on the Web Part button 
which is shown below.  

 

At this point you should see the new SharePoint 2010 UI for adding new Web Parts to a page . Select 
Lists and Libraries in the left -hand section and then select Tasks in the right -hand section. Once you have 

select the Tasks list, make sure the drop -down box on the far right bottom (shown below) has the Left 
Web Part zone selected, then click th e Add button to add the Web Part instance to the page.  

 

16.  Save your changes by selecting the Edit tab in the ribbon and select Stop Editing. Now that you 
have completed this exercise, you should have a page that looks like the one shown below.  
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In this exercise you got some hands-on experience in working with improvements to the SharePoint user interface 
such as the new ribbon and adding Web Parts to a page. 

Exercise 3: Working with PowerShell Scripts  

In this exercise you will get some exposure to working with PowerShell and the PowerShell add-in created for 
SharePoint 2010. 

1.  Launch the PowerShell console from Windows  Start menu. Youôll find the PowerShell shortcut in the 
Start menu called Windows PowerShell V2 (CPT3). Select the Windows PowerShell V2 (CPT3) shortcut, not 

the ñISEò shortcut. Please note that in this step you should be launching the PowerShell console 
from standard PowerShell menu item and not SharePoint -specific menu item under Administrative 

Tools. 

2.  Once you have a command prompt in the Power Shell console windows, type the following 
command using the Set - Location  cmdlet and single parameter with a path on the local c:\ drive 
and press [Enter] . This is the equivalent of the well -known DOS CD command.  

Set - Location c: \ Student \ Labs \ 01_Roadmap\ Powershell \  

3.  The current folder of the PowerShell console should now be located in a folder that has several 
PowerShell scripts (*.ps1 files) that will be used in this lab. Type the following command which 

uses the Get - ChildItem  cmdlet and passes no parameters and press [Enter]  to see a listing of all 
the .ps1 files in this folder.  

Get - ChildItem  

4.  Type in the following command to open Notepad and the script named Hello.ps1 . Press [Enter]  
after typing the command to execute it.  

Notepad Hello.ps1  

5.  After examining the  PowerShell code inside Hello.ps1 , attempt to run it by typing . \ Hello.ps1  

and pressing [Enter] . If the PowerShell scripting support on your VM still has the default 
execution policy of restricted, the script will not run at all. If the execution policy ha s been 
changed to unrestricted, the console will prompt you whether to run the script or not. When 
writing and testing PowerShell scripts, it is easiest to change the execution policy to Bypass so 

that scripts can freely run without any user prompts. Type the following command and press 
[Enter]  to enable scripting support.  

Set - ExecutionPolicy ByPass  

6.  Now, try to run the script named Hello.ps1  a second time by attempt to run it by typing 
. \ Hello.ps1 and pressing [Enter] . You should now see the script is able to run and output a 
simple message to the PowerShell console.  

7.  Now it's time to move to a better script editor. Open the Windows PowerShell ISE from the Windows 
Start menu. ISE stands for Integrated Scripting Environment.  



Lab 01: Getting Started with SharePoint 201 0 Development    

© 2009 Critical Path Training, LLC Ȥ All Rights Reserved   Microsoft Confidential  

© 2009 Microsoft Corporation Ȥ All Rights Reserved    Page 9  

 

8.  Open Hello.ps1  once again in the Windows PowerShell ISE. Drop down the Debug menu and you 
should see it gives you the ability to run and debug the code inside a PowerShell script. Execute 
Hello.ps1  by pressing [F5]  and examine the output.  

9.  Make a small change to the text message inside Hel lo.ps1  that is assigned to the variable named 
$HelloMessage  and save your work.  

$HellowMessage = "Sample message"  
Write - Host " ----------------------------------- "  
Write - Host "Hello World of Powershell Scripting"  
Write - Host "Host name: "$(Get - Item env: \ computerName).value  
Write - Host $HellowMessage  
Write - Host " ----------------------------------- "  

Run Hello.ps1 one more time in the PowerShell console. You should see your changes and also 

observe how easy it is to edit and run PowerShell scripts.  

10.  Now, it's tim e to practice debugging and single stepping through a PowerShell script. Set a 
breakpoint by right -clicking a line and selecting Toggle Breakpoint or by pressing [F9] in the first line 
in Hello.ps1 . Now, press [F5] to begin execution. The execution should stop and the breakpoint 
you set. Now, click [F11] repeatedly to single step through the remaining lines of code inside the 

script.  

11.  Open the script named LoadSharePointSnapin.ps1 . Examine the PowerShell script code inside. 

There is call to the Add- PSSnapin  cmdlet that loads the snap - in for SharePoint 2010 named 
Microsoft.SharePoint.Powershell .  

12.  Now, leave the Windows PowerShell ISE and return the PowerShell console window. Run script by 

typing . \ LoadSharePointSnapin.ps1  and pressing [Enter] . At this point, y ou can call the cmdlets 
provided by the Microsoft.SharePoint.PowerShell  snap - in.  

13.  Run the Get - Command cmdlet with the following parameter and press return to see a listing of all 
the cmdlet included with the Microsoft.SharePoint.PowerShell  snap - in.  

Get - Command - PSSnapin Mi crosoft.SharePoint.PowerShell  

14.  In the last step, there are too many cmdlets in Microsoft.SharePoint.PowerShell  to be able to see 
them all at once in the console windows. Try running the Get -Command cmdlet again but this 
time requesting only the cmdlets based on the cmdlet verb of Get . 

Get - Command - PSSnapin Mi crosoft.SharePoint.PowerShell  - Verb Get  

15.  Run the Get - Command again with the Verb  parameter and pipe the output to a new text file named 
SP2010Cmdlets.txt . 

Get - Command - PSSnapin Micro soft.S harePoint.PowerShell | out - file ðfilepath 
òc:\ SP2010Cmdlets.txt ó 

16.  Open SP2010Cmdlets.txt  with Notepad using the following command to inspect the cmdlets 
provided by the Microsoft.SharePoint.PowerShell  snap - in.  

Notepad SP2010 Cmdlets.txt  
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17.  Now it is time for yo u to create a new SharePoint 2010 site collection using the New- SPSite  

cmdlet. Begin by typing the following command and pressing [Enter]  to get help information on 
the New- SPSite  cmdlet which will show you a list of parameters and indicate which ones are 
mandatory and which ones are optional . Note that optional parameters are enclosed in square 
brackets.  

Get - Help New - SPSite  

18.  Experiment with the New- SPSite  cmdlet to create a new site collection using the parameter values 
shown below. When you have completed this step you should be able to navigate to the top - level 
site at http://moss.contoso.com/sites/Lab01C.  

Url : http://moss.contoso.com /sites/Lab01C  

OwnerAlias : Contoso \ Administrator  

Template : STS#1  

Name : Lab01C  

19.  Open the PowerShell script named CreateContoso SalesSite.ps1  in the Windows PowerShell ISE. 

Review the PowerShell script code inside. Now return to the PowerShell console and run the 
following command from the PowerShell console to call this script and create a new site.  

. \ Create Contoso SalesSite.ps1  Lab01D 

20.  When you have successfully run the script in the previous step, you should see an output 
message like the one shown below.  

New Contoso  site successfully created  
-------------------------------------  
Title: Contoso  Site: Lab01D  
URL: http://moss.contoso .com /sites/Lab01D  
ID: [GUID value  of the new SPSite created ]  

21.  Navigate to the new site at the URL of http://moss.contoso.com/sites/Lab01D and make sure the top -
level site behaves as you would expect.  

In this exercise you got some hands-on experience in working with some of the provided SharePoint 2010 
PowerShell cmdlets as well as working with custom PowerShell scripts. 

Exercise 4: Programming with the SharePoint 2010 object model  

In this exercise you will create a new console application that program against the WSS ó14ô object model to create 
new lists and add items to a SharePoint 2010 site. This will illustrate some on the aspects of the WSS object model 
as well as show some of the issues about which versions of assemblies to use when do this type of programming. 

1.  If you haven't already done so, you need to run the batch file named LabSetup.bat  to create the 
site located at http://moss.contoso.com/sites/Lab01. 

2.  Open the browser and navigate to the new site at  http://moss.contoso.com/sites/Lab01/default.aspx. You 

should see that this new site has been created as a blank site that has no existing lists. In the 
following steps you are going to write a program that uses the SharePoint 2010 object model to 
create a  few new lists in this site and to populate these lists with sample data.  

3.  Launch Visual Studio 2010 from Windows  Start menu.  

4.  Create a new console application named Lab01_OM. Create this new project at a location of 

c: \ Student \ Labs \ 01_Roadmap. Make sure to create the new project based on .NET Framework 3.5 
instead of the default which will be .NET Framework 4.0. This is controlled by one of the drop downs 
found above the list of project templates as shown in the following figure.  

http://wingtipserver/sites/Lab01D
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5.  Once the new project has b een created, right -click on the Lab01_OM project in the Solution Explorer 

and click on Properties to see the Project Properties view. Go to the Application tab of project properties 
and verify that .NET Framework Version 3.5 is select as the Target Framework. It is important for you to 
acknowledge that SharePoint 2010 is based on .NET Framework version 3.5 and not version 4.0.  

 

6.  Click on the Build tab and verify that the target Platform is x64. If not, make sure to change the 
platform to x64 or Any CPU.  
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7.  Now add a reference to the assembly Microsoft.SharePoint.dll  which contains the core classes of 
the WSS ó14ô object model. Note that this assembly will have a caption of Windows SharePoint 

Services if it is displayed in the Add Reference dialog.  

However, i f the assembly cannot be found in the .NET tab, you might have to select the Browse 
tab and navigate to the following path to add the reference.  

C: \ Program Files \ Common Files \ Microsoft Shared \ Web Server Extensions \ 14\ ISAPI \ Microsoft.SharePoint.dll  

8.  Next, ad d a reference to the main assembly for ASP.NET named System.Web  as shown below.  

 

9.  Now it's time to write some code against the SharePoint object model to enable the Developer 
Dashboard. Modify program.cs  to look like this.  

using System;  
using Microsoft.Sha rePoint;  
using Microsoft.SharePoint.Administration;  
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namespace Lab01_OM {  
  class Program {  
    static void Main() {  
      SPPerformanceMonitor SPPerfMon;  
      SPPerfMon = SPFarm.Local.PerformanceMonitor;  
      SPPerfMon.DeveloperDashboardLevel = SPPerfor manceMonitoringLevel.On;  
      SPPerfMon.Update();  
    }  
  }  
}  

10.  Run the application by pressing [CTRL]+[F5] . Once the program runs, return to the Internet 
Explorer and site at http://moss.contoso.com/sites/Lab01/default.aspx. Refresh the page and you should  
see the SharePoint 2010 Developer Dashboard at the bottom of the page.  

 

11.  Go back to Visual Studio and update the code in the static Main  method to assign a value of 
SPPerformanceMonitoringLevel.Of f  instead of SPPerformanceMonitoringLevel.On  and run the 

pr ogram again. Go back to the Internet Explorer and refresh the page again. You should see that 
the Developer Dashboard is now gone. Now you know how to make the Developer Dashboard 
appear and disappear just by running code against the SharePoint 2010 object  model.  

12.  Now, it time to write code that programs against the top - level site you created at the beginning of 
this exercise. Modify the Main  method in program.cs  to create a new SPSite  object to program 

against the new site collection. Make sure to structure  your code inside a using  construct so that 
your code makes an implicit call to the Dispose  method to prevent leakage. As a first step, obtain 
a reference to the SPWeb object for the top - level site and print the Title  property of the site to the 
console wi ndows. Your code should look something like the code below. When you are done 
writing this code, run your program to make sure it runs without errors and displays the proper 
site title.  

static void Main() {  
  string targetSiteUrl = "http://moss.contoso.com /sites/Lab01";  
  using (SPSite siteCollection = new SPSite(targetSiteUrl)) {  
    SPWeb site = siteCollection.RootWeb;  
    Console.WriteLine(site.Title);  
  }  
  Console.ReadLine();  
}  

13.  In this next step you will add an existing source file to your project that  contains utility classes 
which program against the SharePoint 2010 object model and you will use these classes to create 
lists and add Web Parts. Right -click on the project in the Solution Explorer and select the Add 

Existing Item command. Add the existin g source file inside the 
C: \ Student \ Labs \ 01_Roadmap\ StarterFiles  folder named Lab01_Utilties.cs .  

14.  The new source file named Lab01_Utilties.cs  contains three utility classes named 

TasksListFactory , AnnouncementsListFactory  and WebPartPageDesigner . The first  two classes contain 
code to create new list instances and to populate them with sample data. The third class named 
WebPartPageDesigner  programs against a class named SPLimitedWebPartManager  which is provided 
by the SharePoint 2010 object model to delete a nd add Web Part instance from a target Web Part 
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Page. Take a moment to examine the three classes inside Lab01_Utilties.cs  in order to 
understand how it is leveraging the SharePoint 2010 object model.  

15.  Now itôs time to modify the Main  method in program.cs  to  use the three utility classes in 

Lab01_Utilities.cs . Modify the code within the using  construct in Main  so that it looks like the 
code below.  

  using (SPSite siteCollection = new SPSite(targetSiteUrl)) {  
    SPWeb site = siteCollection.RootWeb;  
 
    strin g TasksListTitle = "Tasks";  
    string TasksListDescription = "Contoso Tasks";  
    TasksListFactory.Create(site, TasksListTitle, TasksListDescription);  
 
    string AnnouncementsListTitle = "Announcements";  
    string AnnouncementsListDescription = "Contoso  Announcements";  
    AnnouncementsListFactory.Create(site,  
                                     AnnouncementsListTitle,  
                                     AnnouncementsListDescription);  
 
    WebPartPageDesigner.ClearAll(site, "default.aspx");  
    WebPartPageDesigner.AddXsltListViewWebPart(site, "default.aspx",  
                                               "Tasks", "Left");     
    WebPartPageDesigner.AddXsltListViewWebPart(site, "default.aspx",  
                                               "Announce ments", "Left");  
  }  

16.  Once you have modified the Main  method with the code shown above, run the program by 
pressing [CTRL]+[F5] . When the program runs, it should add two new lists to the target Blank site 
and add two new Web Parts to the home page ( http://moss.contoso.com/sites/Lab01/default.aspx) to 
display the contents of these two lists as shown in the following figure:  

 

In this exercise you learned how to enable the Developer Dashboard and how to work with the SharePoint object 
model to modify an existing SharePoint site. 

 



Lab 02: Visual Studio 2010 SharePoint Tools    

© 2009 Critical Path T raining, LLC Ȥ All Rights Reserved   Microsoft Confidential  

© 2009 Microsoft Corporation Ȥ All Rights Reserved    Page 15  

 Lab 02: Visual Studio 2010 SharePoint Tools  

Lab Time: 45 minutes 

Lab Folder: C:\Student\Labs\02_VS2010_SPT 

Lab Overview: In this lab you will begin using the Visual Studio 2010 SharePoint Tools (SPT). This will give you a chance to 
become familiar with the standard project structure used by SPT. You will go through the steps of creating and testing a project that 
contains a Feature, a Feature Receiver and a Web Parts. Along the way you will learn to configure SPT deployment options as well 
debug an SPT project by single-stepping through the code in your solution. 

Lab Setup Requirements  

¶ Before you begin Exercise 1 of this lab, you must run the batch file named SetupLab02.bat. This batch file creates a new blank site collection at 

the location http://moss.contoso.com/sites/Lab02. This is the site you will use to test and debug the code you are going to write with the Visual 

Studio 2010 SharePoint Tools. 

Exercise 1: Creating a SharePoint 2010 Project  

In the first exercise, you will create an empty project and focus on the aspects of the Visual Studio 2010 SharePoint 
Tools that are common across all projects created with this toolset. Most of your work will involve changing the 
properties of the project and properties of the project's main feature. 

1.  If you havenôt already done so, run the batch file named SetupLab02.bat , found in  the 

c: \ Student \ Labs \ 02_VS2010_SPT\  folder, to create the new site collection that will be used to test 
and debug the code you will be writing in this lab. This batch  file creates a new site collection at 
an URL of http://moss.contoso.com/sites/Lab02. 

2.  Launch the Internet Explorer and navigate to the top - level site at http://moss.contoso.com/sites/Lab02. 

You should observe that the newly -created site is a Blank site. Th is is the site you will use to test 
and debug the project you will develop throughout this entire lab exercise.  

 

3.  Now launch Microsoft Visual Studio 2010 with administrator privileges by right -clicking on its Start 
menu shortcut and clicking the Run as Administrator option. Starting Visual Studio in this manner 

(i.e. with administrative permissions) makes Visual Studio debugger work correctly when 
attaching to the SharePoint worker process.  
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4.  Create a new Visual Studio project named ContosoWebParts based on  the SharePoint Tools project of 

type Empty Project. You can find this project type using the path Visual C# » SharePoint » 2010. Ensure 
the .NET Framework 3.5 is selected instead of the default .NET Framework 4.0. Click OK to start the 
SharePoint Customization Wizard. 

 

5.  When the SharePoint Customization Wizard prompts you for a local debugging site, enter the URL of 
http://moss.contoso.com/sites/Lab02. Change the trust level to Deploy as a full-trust solution and then click 
Finish. 

 

6.  Once the new project h as been created, you should be able to observe it has four nodes: 
Properties, References, Features and Package. While the first two nodes are standard on all Visual 
Studio projects, the Features node and the Package node are unique to projects create with the 
Visual Studio 2010 SharePoint Tools.  
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7.  Right -click on the node for the default feature added by the SharePoint tools named Feature1 click 
Rename. Rename this feature to Main. 

 

8.  Open the Main feature in the feature designer. Use the feature designer to change the featureôs 
Title and Description using the following values:  

Title:  Custom Web Parts  

Description:  My very first project using the Visual Studio 2010 Tools  

9.  .You must also change the Scope setting of the Main feature from the default value of Web to a 

value of Site. Don't be confused here. Remember a Scope setting of Web results in site - level 
activation of the feature while a Scope setting of Site results in activation at the site collection level. 
The change of the feature's Scope setting to Site is required due to the fact that Web Parts 

deployment requires a feature which activates at site collection scope in order to properly deploy 
Web Part description files.  
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10.  Now you are going to add a few graphic images into your project so they are deployed  inside the 
SharePoint Images folder. The first step to doing this correctly is to add a mapped folder to your 
project for the SharePoint Images folder. Accomplish this by right -clicking the ContosoWebParts 
project in the Solution Explorer, expanding the Add menu and selecting the SharePoint "Images" 

Mapped Folder command.  

 

11.  After completing the previous step you should be able to see that there is an Images directory 

inside your project. You should also be able to observe that there is a child folder insid e the Images 
folder with the same name as the project ContosoWebParts. This demonstrates how the SPT helps to 

ensure best practices with SharePoint development. When adding image files to your project, do 
not add them directly inside the Images folder. Ins tead, add them to the inner directory in this case 
named ContosoWebParts to avoid file name conflicts with the image files that Microsoft deploys 
inside the Images directory.  

12.  There are three GIF files inside the folder C: \ Student \ Labs \ 02_VS2010_SPT\ Starter Files . These files 
are named FeatureIcon.gif  and SiteIcon.gif , WebPartIcon.gif . Right -click on the ContosoWebParts 
folder inside the Images folder and select the Add » Existing Items... command. When the resulting 

dialog opens, navigate to the folder locat ion that contains the GIF files. Add all three GIF files to 
the project.  
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13.  The first GIF file that you will put to use is the FeatureIcon.gif  by modifying the Image Url property 
of the Main feature.  

a)  Open the Main feature in the feature designer and make s ure it is the active window.  

b)  Find the property sheet for the Main feature.  

c)  Update the Image Url property with an URL that is relative to the Images which should be 

ContosoWebParts \ FeatureIcon.gif . 

 

14.  Save all the work you have done to the Main feature.  

In this exercise you created your first feature using the SPT tools and added a mapped folder to the project. In future 
exercises youôll add additional pieces to the project to make it more useful. 

Exercise 2: Adding a Feature Event Receiver  

In exercise 1 you learned how to modify project properties and features properties using visual designers and 
property sheets. Now you are going to add some code. Over the next few steps, you are going to add a feature 
receiver so you can write code against the SharePoint object model that will automatically execute during feature 
activation and feature deactivation. 

1.  Add an event receiver by right -clicking on the Main feature  node in the Solution Explorer and 
clicking on the context menu with the caption of Add Event Receiver. 
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2.  Open the source file named Main.EventReceiver.cs  and inspect what  is inside . You should be able 
to see that there are several method stubs inside the class definition that are commented out. 
There is also a GUID attribute that has been applied to the receiver class to give a unique 
identifier. Do not remove the GUID from the class because it will be used behind the scenes by the 

SPT during the packaging process. Uncomment the two methods named FeatureActivated  and 
FeatureDeactivating . Then remove all t he extraneous comments so your code looks like this.  

using System;  
using System.Runtime.InteropServices;  
using System.Security.Permissions;  
using Microsoft.SharePoint;  
using Microsoft.SharePoint.Security;  
 
namespace ContosoWebParts.Features.Main {  
   
  [Gu id("19d897a9 - 1520 - 48aa - 87e1 - 0eaa12c08c88")]  // your GUID will be different  
  public class MainEventReceiver : SPFeatureReceiver {  
 
    public override void FeatureActivated(SPFeatureReceiverProperties properties) {  
 
    }  
 
    public override void Feature Deactivating(SPFeatureReceiverProperties properties) {  
    }  
  }  
}  

3.  Implement the FeatureActivated  method to modify Title  property and the ImageUrl  property of 
the top - level site and to call the Update  method to save this modification back to the content 
database. Before changing of the Title property, your code should track its original value so that 
your feature can restore it upon feature deactivation. Implementation the FeatureActivated 
method using the following steps.  

a)  Obtain the SPSite  reference which point to the site collection in which the feature is being activated.  

b)  Obtain a SPWeb reference which points to the top - level site  

c)  Query to top - level site's Title  property and store the value as a name/value pair inside the 
SPWeb.Properties  collection.  

d)  Modify the site's Title  property with a creative text value such as "VS2010 SPT Rocks!"  

e)  Modify the site's SiteLogoUrl  property to point to SiteIcon.gif  inside the Images  folder.  

_layouts/images/ContosoWebParts/SiteIcon.gif;  

f)  Your code should  like something li ke this.  

public override void FeatureActivated(SPFeatureReceiverProperties properties) {  
  SPSite siteCollection = properties.Feature.Parent as SPSite;  
 
  if (siteCollection != null) {  
    // save top site's original Title and SiteLogoUrl  
    SPWeb site = siteCollection.RootWeb;  
    site.Properties["OriginalTitle"] = site.Title;  
    site.Properties.Update();  
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    // update the Title and SiteIconUrl  
    site.Title = "VS 2010 SPT Rocks";  
    site.SiteLogoUrl = "_layouts/images/ContosoWebParts/SiteIcon.gif";  
    site.Update();  
  }  
}  

4.  Now, implement FeatureDeactivating  so that your code restores the original Title  property value 
and changes the SiteLogoUrl  property value back to an empty string.  

public override void FeatureDeactivating(SPFeatureReceiverProperties  properties) {  
  SPSite siteCollection = properties.Feature.Parent as SPSite;  
 
  if (siteCollection != null) {  
    // restore top site's original Title and SiteLogoUrl  
    SPWeb site = siteCollection.RootWeb;  
    site.Title = site.Properties["OriginalTitle "];  
    site.SiteLogoUrl = string.Empty;  
    site.Update();  
  }  
}  

5.  Right -click on the ContosoWebParts project in Solution Explorer and run the Build command. This will 

ensure that all the code you have written in this exercise compiles. If that are compilat ion errors 
in your code, fix them until you are able to run the Build command without any errors.  

You have now implemented the feature receiver. Save all your work and move on to the next exercise where you will 
deploy and test this code. 

Exercise 3: Deplo ying and Debugging SPT Projects  

Now it's time to test your work and see how your project behaves when tested inside a SharePoint site collection.   

1.  Start your work by inspecting and configuring the VS 2010 SPT project deployment options.  

a)  Right -click on the  ContosoWebParts project node in the Solution Explorer and click Properties. 

b)  Navigate to the Deploy tab to see the project deployment options.  

c)  Note that there are two text boxes that allow you to add command - line instructions which will execute 

either just  before and directly after the SPT deploy steps are processed. You are not going to add 
anything to either of the two top text boxes.  

d)  Find the combo box control with the caption Active Deployment Configuration and change the selected 
item from Default to No Activation. 

e)  Inside the Edit Configurations list box, select the No Activation configuration and click the Viewé 

button to inspect its deployment configuration steps.  

f)  Click OK to close the View Deployment Configuration dialog. Save all your work and clos e the page 

which shows the project properties.  
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6.  Now it's time to run the Deploy command. First, make sure the Output Window is visible so you can 
see how the things progress during the execution of the Deploy command. Then right -click on the 
ContosoWebParts project in Solution Explorer and run the project Deploy command.  

 

7.  Examine the Output Window after the Deploy command has completed. Verify the steps that 
provided output to the Output windows.  

 

8.  At this point, the solution package for the ContosoWebParts project has been deployed on the local 

SharePoint. Let's test out your work by trying to activate the feature you defined inside the 
ContosoWebParts project.  

a)  In browser, navigate to the test site at http://moss.contoso.com/sites/lab02.  

b)  Click Site Actions » Site Settings to navigate to the Site Settings page.  

c)  Inside the Site Collection Administration section of the Site Settings page, click on the Manage site 

collection features link to navigate to the Site Collection Administration >  Features page.  

d)  Locate the feature you have been working on with a title of Contoso Web Parts. You should also be 

able to see the feature's custom feature icon.  
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e)  Activate the Contoso Web Parts feature. If you return to the site's home page you should be able to 

verify that  the code inside the FeatureActivated  event handler executed and changed the site's title 
and its site icon.  

 

f)  Now, navigate back to the Site Collection Administration for  Features page. Deactivate the Contoso Web 

Parts feature so that you can test the cod e in the FeatureDeactivating  event handler. Return to the 

site's home page and verify that the site title has been restored to its original value and that the site 
icon has been changed back to the default site icon for SharePoint sites.  

 

9.  Now it's time to  practice entering debug mode so that you can single step through the code while 
it's executing inside the context of the test site.  

a)  Open the source file Main.EventReceiver.cs  and add a breakpoint to FeatureActivated . 

 

b)  Start the project in debug mode by r unning Debug » Start Debugging menu command or pressing the 
equivalent shortcut key which is [F5].  

c)  After running the Start Debugging command wait until the Visual Studio debugger has launched the 
Internet Explorer and navigated to the test site.  

d)  Within t he test site, navigate to the Site Collection Administration >  Features page and activate the 

Contoso Web Parts feature. At this point you should fall into the Visual Studio debugger and break at 

the line where you set of the breakpoint. If you do not fall  into the Visual Studio debugger when you 
first activate the feature, try to deactivate and reactivate the feature.  
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e)  Press the [F11] key to single -step through the remaining lines of code. You should be able to hit [F11] 

repeatedly until the Visual Studio  debugger relinquishes control back to the Internet Explorer.  

f)  Return to Visual Studio and stop the debugger by running the Debug » Stop Debugging menu 
command or by pressing the equivalent shortcut key which is [Shift]+[F5]. 

In this exercise you deployed and tested your custom SPT project as well as saw the native debugging experience. 

Exercise 4: Creating, Deploying and Testing Web Parts  

Given the fact that your project is named ContosoWebParts, it probably makes sense to add a few Web Parts. In the 
remaining exercises you will add two new SPIs to the project using the Web Part template. Keep in mind that Web Part 
template is just one of the many different SharePoint Item (SPI) types included with the Visual Studio 2010 
SharePoint Tools. 

1.  Add a new Web Part to the ContosoWebParts project named HelloPart. 

a)  Right -click on the ContoWebParts project in Solution Explorer and select Add » New Item. 

b)  Select the Web Part project item template and give it a name of HelloPart. 

 

2.  Inspect the SPI node for the Web Part name d HelloPart. You should be able to verify that it contains 
three SPI files named Elements.xml , HelloPart.cs  and HelloPart.webpart . 
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3.  Open the file named HelloPart.webpart  and make the following modifications.  

a)  Find the element for the Title property and cha nge its value to The "Hello" Web Part. 

b)  Find the element for the Description property and change its value to something else.  

<?xml version="1.0" encoding="utf - 8"?>  
<webParts>  
  <webPart xmlns="http://schemas.microsoft.com/WebPart/v3">  
    <metaData>  
      <type name="ContosoWebParts.HelloPart.HelloPart,  
                  $SharePoint.Project.AssemblyFullName$" />  
      <importErrorMessage>$Resources:core,ImportErrorMessage;</importErrorMessage>  
    </metaData>  
    <data>  
      <properties>  
        <property  name="Title" type="string"> The "Hello" Web Part </property>  
        <property name="Description" type="string">A most compelling Web Part </property>  
      </properties>  
    </data>  
  </webPart>  
</webParts>  

4.  In addition to the property values for Title and Description, add three more additional Web Part 

properties to HelloPart.webpart  using the name/value pairs the following table.  

ChromeType:  TitleAndBorder  

CatalogIconImageUrl:  _layouts/images/ContosoWebParts/WebPartIcon.gif  

TitleIconImageUrl:  _layouts/image s/ContosoWebParts/WebPartIcon.gif  

<?xml version="1.0" encoding="utf - 8"?>  
<webParts>  
  <webPart xmlns="http://schemas.microsoft.com/WebPart/v3">  
    <metaData>  
      <type name="ContosoWebParts.HelloPart.HelloPart, 
$SharePoint.Project.AssemblyFullName$" />  
      <importErrorMessage>$Resources:core,ImportErrorMessage;</importErrorMessage>  
    </metaData>  
    <data>  
      <properties>  
        <property name="ChromeType" type="chrometype">TitleAndBorder</property>  
        <property name="Title" type="string">Th e "Hello" Web Part</property>  
        <property name="Description" type="string">The mother of all other Web 
Parts.</property>  
        <property name="CatalogIconImageUrl" 
type="string">_layouts/images/ContosoWebParts/WebPartIcon.gif</property>  
        <pr operty name="TitleIconImageUrl" 
type="string">_layouts/images/ContosoWebParts/WebPartIcon.gif</property>  
      </properties>  
    </data>  
  </webPart>  
</webParts>  

5.  Open the Web Parts elements.xml  and make the following modifications.  

a)  Modify the URL attribute  of File element to change the .webpart file name to ensure that it is unique. 
Do this by appending the text value of "ContosoWebPart_" to the beginning of the URL property value.  

<?xml version="1.0" encoding="utf - 8"?>  
<Elements xmlns="http://schemas.micro soft.com/sharepoint/" >  
  <Module Name="HelloPart" List="113" Url="_catalogs/wp">  
    <File Path="HelloPart \ HelloPart.webpart"  
          Url="ContosoWebPart_HelloPart.webpart"  
          Type="GhostableInLibrary">  
      <Property Name="Group" Value="Custo m" />  
    </File>  
  </Module>  
</Elements>  

b)  Change the value for the Group property to "Contoso Web Part". 

<?xml version="1.0" encoding="utf - 8"?>  
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<Elements xmlns="http://schemas.microsoft.com/sharepoint/" >  
  <Module Name="HelloPart" List="113" Url="_catalog s/wp">  
    <File Path="HelloPart \ HelloPart.webpart"  
          Url="ContosoWebPart_HelloPart.webpart"  
          Type="GhostableInLibrary">  
      <Property Name="Group" Value="Contoso Web Parts" />  
    </File>  
  </Module>  
</Elements>  

6.  Open the C# source fil e named HelloPart.cs . Modify the code with this very simple starting point 
for a Web Part class implementation.  

namespace ContosoWebParts.HelloPart {  
  public class HelloPart : WebPart {  
 
    protected Label lblOutput;    
 
    protected override void Creat eChildControls() {  
      lblOutput = new Label();  
      lblOutput.Text = "Hello Web Part";  
      Controls.Add(lblOutput);  
    }  
  }  
}  

7.  Build the ContosoWebParts project and make sure there are no compilation errors. If there are 
errors when running the Build command, find and fix these errors until you can run the Build 
command without experiencing any errors.  

8.  Run the Deploy command which will retract and deploy the solution package for the ContosoWebParts 

project.  

9.  In browser, navigate to the test site at http://moss.contoso.com/sites/lab02 and follow these steps to go 

through the activation process.  

a)  Click Site Actions » Site Settings to navigate to the Site Settings page.  

b)  Inside the Site Collection Administration section of the Site Settings page, click on the Manage site 

collection features link to navigate to the Site Collection Administration >  Features page.  

c)  Locate the Contoso Web Parts and activate it . If it was already active, then deactivate first and then 

activate it. The key point here is that feat ure activation is what provisions the .webpart file into the 
Web Part Gallery which will allow you to test your work.  

10.  Now it is time to add test instance of the Web Part you have just created to a Web Part Page. 
Navigate to the home page default.aspx. The ribbon at the top of the page should have a tab titled 

Edit. Click on the Edit tab and then select the command from the Edit Page button that takes you 
into the mode for adding, modifying and deleting Web Parts from the page. Make sure the Left 
Web Part zo ne is selected (indicated by a dotted border around the zone) so that contextual Page 

Tools ribbon tab group is displayed. Click on the Insert tab on the ribbon and click on the Web Part 
button which is shown in the following screenshot.  

 

11.  At this point yo u should see the new SharePoint 2010 UI for adding new Web Parts to a page. You 
should be able to standard Web Part Categories  such as Lists and Libraries, Authoring and Content 

Rollup. You should also be able to see a new custom category named Contoso Web Parts which you 
created when you edited the Group property value inside the elements.xml  file. When you select the 
Contoso Web Parts category in the left -hand section, you should be able to see your Web Part in the 
right -hand section with a title of The "Hello" Web Part that you added to HelloPart.webpart . Once you 
have select the The "Hello" Web Part, make sure the drop -down box on the far right bottom (shown 
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below) has the Left Web Part zone selected, then click the Add button to add the Web Part instanc e 

to the page.  

 

12.  At this point, you have gone through all the required steps to create, deploy and test a Web Part. 
The test instance of your Web Part should look like the following screenshot.  

 

In this exercise you created a Web Part, added it to your project and added it to the sample SharePoint site. 

Exercise 5: Creating a Visual Web Part with AJAX Behavior  

Now you will add a second Web Part using the Visual Web Part template. This makes it possible to create the UI for 
a Web Part using an ASP.NET User Control and the Visual Studio User Control Designer. You will also use the 
UpdatePanel control from ASP.NET AJAX to give your Web Part a Web 2.0 user experience eliminating postbacks. 

1.  Add a new Web Part to the ContosoWebParts project named ListInspector. 

a)  Right -click on the ContoWebParts project in Solution Explorer and select Add » New Item. 

b)  Select the Visual Web Part project item template and give it a name of ListInspector. 
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2.  Inspect the SPI node for the Web Part named ListInspector. Verify that it contai ns the SPI files 

named Elements.xml , ListInspector.cs , ListInspector.webpart , ListInspectorUserControl.ascx  and  

ListInspectorUserControl.ascx.cs . 

 

3.  Open the Web Part Description file named ListInspector.webPart  and examine the XML content 
inside. You shoul d see the XML already contains two property elements for the Title property and the 

Description property. Update this Web Part Description file this so that it contains a property element 

and an associated value for each of the name/value pairs in the foll owing table.  

ChromeType : TitleAndBorder  

Title : List Inspector Web Part  

Description : A Web Part which shows all the lists in the current site and allows you to get several of its property values.  

CatalogIconImageUrl : _layouts/images/ContosoWebParts/WebPartI con.gif  

TitleIconImageUrl : _layouts/images/ContosoWebParts/WebPartIcon.gif  

4.  Open the Web Parts elements.xml  and make the following modifications.  

a)  Modify the URL attribute of File element to change the .webpart file name to ensure that it is unique. 
Do this by appending the text value of "ContosoWebPart_" to the beginning of the URL property value.  

<?xml version="1.0" encoding="utf - 8"?>  
<Elements xmlns="http://schemas.microsoft.com/sharepoint/" >  
  <Module Name="ListInspector" List="113" Url="_catalogs/wp">  
    <File Path="ListInspector \ ListInspector.webpart"  
          Url="ContosoWebPart_ListInspector.webpart"  
          Type="GhostableInLibrary" >  
      <Property Name="Group" Value="Custom" />  
    </File>  
  </Module>  
</Elements>  

b)  Change the value for the Group property to "Contoso Web Part". 

<?xml version="1.0" encoding="utf - 8"?>  
<Elements xmlns="http://schemas.microsoft.com/sharepoint/" >  
  <Module Name="ListInspector" List="113" Url="_catalogs/wp">  
    <File Path="ListInspector \ ListInspector.webpart"  
          Url="ContosoWebPart_ListInspector.webpart"  
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          Type="GhostableInLibrary" >  
      <Property Name="Group" Value="Contoso Web Parts" />  
    </File>  
  </Module>  
</Elements>  

5.  Add an assembly reference to the ContosoWebParts project for the assembly n amed 
System.Web.Extensions. This reference is required because developing the new Visual Web Part will 
involve the UpdatePanel control from ASP.NET AJAX.  

6.  Open the User Control file for the Visual Web Part named ListInspectorUserControl.ascx . You 

should be able to experiment by moving back and forth between design view and code view. When 
you are in design view, the designer should be empty at first as no controls or HTML text has been 
added.  

7.  Make sure the User Control is in design view. Also ensure that the  Visual Studio toolbox is visible. 
Look inside the AJAX Extensions section of the toolbox and find the UpdatePanel control as shown in 
the following screenshot. Drag and drop the UpdatePanel control onto the user control designer.  

 

8.  Switch the User Control  back to code view. Note that the User Control designer added a reference 
to the System.Web.Extensions assembly when you added the UpdatePanel  control. Your code view 
should look like what is shown in the following code block.  

<%@ Assembly Name="$SharePoin t.Project.AssemblyFullName$" %>  
<%@ Assembly Name="Microsoft.Web.CommandUI, [4 - part assembly name]" %>  
<%@ Register Tagprefix="SharePoint" Namespace="Microsoft.SharePoint.WebControls"  
    Assembly="Microsoft.SharePoint, [4 - part assembly name]" %>  
<%@ Register Tagprefix="Utilities" Namespace="Microsoft.SharePoint.Utilities"  
    Assembly="Microsoft.SharePoint, [4 - part assembly name]" %>  
<%@ Import Namespace="Microsoft.SharePoint" %>  
<%@ Register Tagprefix="WebPartPages" Namespace="Microsoft.SharePoint.We bPartPages"  
    Assembly="Microsoft.SharePoint, [4 - part assembly name]" %>  
<%@ Control Language="C#" AutoEventWireup="true"  
    CodeBehind="ListInspector2UserControl.ascx.cs"  
    Inherits="ContosoWebParts.ListInspector2.ListInspector2UserControl" %>  
 
<%@ Register assembly="System.Web.Extensions, [4 - part assembly name] "  
             namespace="System.Web.UI" tagprefix="asp" %>  
 
<asp:UpdatePanel ID="UpdatePanel1" runat="server">  
</asp:UpdatePanel>  

9.  Add a ContentTemplate  element inside the UpdatePanel  elemen t as shown in the following code 
block. Next, you will copy and paste a pre -provided table layout which contains ASP.NET controls 
from a text file in your lab folder. Using the Windows Explorer, navigate to 
c: \ Student \ Labs \ 02_VS2010_SPT\ StarterFiles . Locat e the file named ListInspectorTable.txt . Open 

the file with NotePad and copy all the text inside to the Windows clipboard. Paste all the text into 
inside the ContentTemplate  element.  

<asp:UpdatePanel ID="UpdatePanel1" runat="server">  
  <ContentTemplate>  
    <! --  paste text from ListInspectorTable.txt here to create HTML table layout -- > 
  </ContentTemplate>  
</asp:UpdatePanel>  
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10.  Switch the User Control back into Design view and verify that you can see the table layout.  

 

11.  Now it's time to write some code to bri ng this Web Part to life. Open the source file named 
ListInspectorUserControl.ascx.cs . Follow these steps to begin the implementation.  

a)  Add a using  statement to import the Microsoft.SharePoint  namespace  

b)  Delete any pre -existing members (properties & methods from the class definition.  

c)  Add a protected file named SelectedListID  based on the GUID type.  

d)  Add a protected file named UpdateListProperties  based on the bool  type.  

e)  Add a method named lslLists_SelectedIndexChanged  using the parameter list shown in the 
foll owing code block. Note that the ContosoWebParts project will not compile until you add this 

method implementation because the pre -provided table layout text you pasted in contains a list box 
named lstLists  containing an attribute which attaches it to an ev ent handler named 
lslLists_SelectedIndexChanged . 

f)  Add an overridden implementation of the OnPreRender  method using the parameter list shown in the 

following code block.  

using System;  
using System.Web.UI;  
using System.Web.UI.WebControls;  
using System.Web.UI. WebControls.WebParts;  
using Microsoft.SharePoint;  
 
namespace ContosoWebParts.ListInspector {  
  public partial class ListInspectorUserControl : UserControl {  
     
    protected Guid SelectedListID = Guid.Empty;  
    protected bool UpdateListProperties = fals e;  
 
    protected void lslLists_SelectedIndexChanged(object sender, EventArgs e) {  
       
    }  
 
    protected override void OnPreRender(EventArgs e) {       
 
    }  
  }  
}  

12.  Provide an implementation for lslLists_SelectedIndexChanged  as follows.  

protected voi d lslLists_SelectedIndexChanged(object sender, EventArgs e) {  
  SelectedListID = new Guid(lstLists.SelectedValue);  
  UpdateListProperties = true;  
}  

13.  Provide an implementation for OnPreRender  do the following.  

a)  Clear the items from the lstLists  control and th en add a new list item for each SPList item in the 

current site. When adding ListItem instances to the ListBox control, use list title as the ListItem Text  

and use list's identifying GUID as the ListItem Value . 

protected void OnPreRender(EventArgs e){  
  ls tLists.Items.Clear();  
  SPWeb site = SPContext.Current.Web;  
  foreach (SPList list in site.Lists) {  
    ListItem listItem = new ListItem(list.Title, list.ID.ToString());  
    lstLists.Items.Add(listItem);  
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  }  
}  

b)  Since you have cleared the list box and re -add ed all the list items, you must reapply the selection 
made by the user. Do this using the following code.  

protected override void OnPreRender(EventArgs e) {  
 
  lstLists.Items.Clear();  
  SPWeb site = SPContext.Current.Web;  
  foreach (SPList list in site.Lis ts) {  
    ListItem listItem = new ListItem(list.Title, list.ID.ToString());  
    lstLists.Items.Add(listItem);  
  }  
 
  if (SelectedListID != Guid.Empty) {  
    lstLists.Items.FindByValue(SelectedListID.ToString()).Selected = true;  
  }  
}  

c)  If the UpdateListPrope rties  field contains a value of true, then update all the Label controls on the 

right -hand side of the table layout to display properties of the selected list. Use the following code 
block to see the names of the Label controls that need to be updated as w ell as the SharePoint object 

model code required.  

protected override void OnPreRender(EventArgs e) {  
 
  lstLists.Items.Clear();  
  SPWeb site = SPContext.Current.Web;  
  foreach (SPList list in site.Lists) {  
    ListItem listItem = new ListItem(list.Title, l ist.ID.ToString());  
    lstLists.Items.Add(listItem);  
  }  
 
  if (SelectedListID != Guid.Empty) {  
    lstLists.Items.FindByValue(SelectedListID.ToString()).Selected = true;  
  }  
 
  if (UpdateListProperties) {  
    SPList list = SPContext.Current.Web.Lists[Sel ectedListID];  
    lblListTitle.Text = list.Title;  
    lblListID.Text = list.ID.ToString().ToUpper();  
    lblListIsDocumentLibrary.Text = (list is SPDocumentLibrary).ToString();  
    lblListIsHidden.Text = list.Hidden.ToString();  
    lblListItemCount.Text = list.ItemCount.ToString();  
    lnkListUrl.Text = list.DefaultViewUrl;  
    lnkListUrl.NavigateUrl = list.DefaultViewUrl;  
  }  
}  

d)  Now, you need to add one final piece of code at the very beginning of the OnPreRender  
implementation to assign a value to the Sele ctedListID  field in cases where the lstLists  controls 
has a selected item but did not generate a postback resulting from a user selecting a different list.  

protected override void OnPreRender(EventArgs e) {  
 
  if ((lstLists.SelectedIndex > - 1) & (!UpdateLi stProperties)) {  
    SelectedListID = new Guid(lstLists.SelectedValue);  
  }  
 
  lstLists.Items.Clear();  
  SPWeb site = SPContext.Current.Web;  
  foreach (SPList list in site.Lists) {  
    ListItem listItem = new ListItem(list.Title, list.ID.ToString());  
    l stLists.Items.Add(listItem);  
  }  
 
  if (SelectedListID != Guid.Empty) {  
    lstLists.Items.FindByValue(SelectedListID.ToString()).Selected = true;  
  }  
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  if (UpdateListProperties) {  
    SPList list = SPContext.Current.Web.Lists[SelectedListID];  
    lblList Title.Text = list.Title;  
    lblListID.Text = list.ID.ToString().ToUpper();  
    lblListIsDocumentLibrary.Text = (list is SPDocumentLibrary).ToString();  
    lblListIsHidden.Text = list.Hidden.ToString();  
    lblListItemCount.Text = list.ItemCount.ToString() ;  
    lnkListUrl.Text = list.DefaultViewUrl;  
    lnkListUrl.NavigateUrl = list.DefaultViewUrl;  
  }  
}  

e)  Build the ContosoWebParts project and make sure there are no compilation errors. If there are errors 

when running the Build command, find and fix these err ors until you can run the Build command 
without errors.  

14.  Now deploy the ListInspector Web Part by right -clicking on the ContosoWebParts project and running 

the Deploy command which will retract the previous version of the project's solution package and 

depl oy the new one.  

15.  In browser, navigate to the test site at http://moss.contoso.com/sites/lab02 and follow these steps to go 

through the activation process.  

a)  Click Site Actions » Site Settings to navigate to the Site Settings page.  

b)  Inside the Site Collection Administration section of the Site Settings page, click on the Manage site 

collection features link to navigate to the Site Collection Administration >  Features page.  

c)  Locate the Contoso Web Parts and activate it . If it was already active, then deactivate first and then 

activate it. The key point here is that feature activation is what provisions the Web Part Description 
file with the .webpart extension into the Web Part Gallery. This is required to complete the next step 
of this exercise.  

16.  Now it is time to  add a test instance of the ListInspector Web Part. Navigate to the home page 

default.aspx . Click on the Edit tab on the ribbon at the top of the page and then select the 
command from the Edit Page button that takes you into the mode for adding, modifying and 
deleting Web Parts from the page. Make sure the Left Web Part zone is selected so that contextual 

Page Tools ribbon tab is displayed. Click on the Insert tab on the ribbon and click on the Web Part 

button. Select the Contoso Web Parts category in the l eft -hand section which should then allow you 
to see the Web Part in the right -hand section with a title of List Inspector Web Part that you added to 
ListInspector.webpart . Select the List Inspector Web Part and  then click the Add button to add the 

Web Part  instance to the Left Zone  of the page. Take the page out of edit mode and the Web Part 
should look the one shown in the following screenshot.  

 

Once you have tested the ListInspector Web Part and verified it can allow the user to see the properties of each list 
in the current site, you have completed all the exercises in this lab. 
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 Lab 03: SharePoint 2010  User Interface Advancements  

Lab Time: 45 Minutes 

Lab Folder: C:\Student\Labs\03_SharePointUI 

Lab Overview: In this lab you will create and customize a list for storing ideas for new toys medicines that Contoso can 
manufacture. While creating and using this list you will use various new features of SharePoint, SharePoint Designer and InfoPath.  

Lab Setup  Requirements  

¶ Before you begin this lab, you must run the batch file named SetupLab03.bat. This batch file creates a new SharePoint site collection at the 

location http://moss.contoso.com/sites/Lab03. 

Exercise 1: Creating  the New Toy Ideas  list  

The first task is to create the list and add columns to it. You will create the list using the new SharePoint Designer user interface. 
Next you will add new columns and items to the list using the new AJAX capabilities of the browser interface. 

1.  If you havenôt already done so, run the batch file named SetupLab0 3.bat , found in  the 
c: \ Student \ Labs \ 03_SharePointUI \  folder, to create the new site collection that will be used to test 

and debug the code you will be writing in this lab. This batch file creates a new site collection at 
an URL of http://moss.contoso.com/sites/Lab03. 

2.  Open SharePoint Designer 2010 and open the http://moss.contoso.com/sites/lab03 site. Examine the new 
overview page that appears.  

3.  In the left -hand navigation pane  select Lists and Libraries. 

4.  On the Ribbon , in the Lists and Libraries tab, choose Custom List. Complete the dialog that appears 
with the following information.  

Name:  New Toy Ideas  

Description:  Stores information about possible new toys .  

 

5.  Within SharePoint Designer 2010, navigate to the New Toy Ideas list by selecting it from the Lists and 

Libraries tab site and examine the overview page.  
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6.  On the New Toy Ideas list overview page, in the Settings section, do the following:  

a)  Check Require content approval for submitted items to enable content approval for the list.  

b)  Uncheck the Allow Attachments option to disallow attachments for list items. In the dialog that appears 
choose OK to confirm this modification.  

7.  On the Quick Access Toolbar section of the ribbon (upper - left corner above the Office 2010 
application logo button), choose Save . 

8.  On the r ibbon , in the Lists Settings tab, expand Preview in Browser and choose Windows Internet Explorer 

8.0 (32 bit) with the  Default Size option . Keep SharePoint Designer open as you will return to it in a 
later point in this exercise.  

Perform the following tas ks in the browser window that opens.  

9.  On the r ibbon , on the List tab, choose Create Column available from the Settings group. Use this 

approach to add the following fields to the list.  

Column Name  Field Type  Required  Additional Information  

Age Group  Choic e Yes Choices:  

1 to 3  

3 to 6  

6 to 9  

9 and older  

Required Investment  Single line of text  Yes -  

Existing Product  Yes/No  -  -  

Alternatives  Multiple lines of text  No Plain text  

Due Date  Date and Time  No Date Only  



Lab 03: SharePoint 2010  User Interface Advancements    

© 2009 Critical Path Training, LLC Ȥ All Rights Reser ved   Microsoft Confidential  

© 2009 Microsoft Corporation Ȥ All Rights Reserved    Page 35  

Take note of the Ajax style refresh when ad ding new list columns  

10.  On the ribbon, in the Items tab, expand New Item and choose New Item. Use the following information 

to complete the dialog.  
Title:  Nuclear powered action figure  

Age Group:  9 and older  

Required Investment:  Miniaturized nuclear power pl ant .  

Existing Product:  No 

Take note of the Ajax style refresh when adding new list items  

11.  Switch back to SharePoint Designer and keep the browser window open.  

In this exercise you created & modified a list using SharePoint Designer 2010 as well as add columns using the new 
ribbon in the browser. Finally, you interacted with the list by adding a new list item. 

Exercise  2: Customizing the All Items view  

Now that the list is in place and has some data in it, the second step is to modify the default óAll Itemsô view of the list. SharePoint 
2010 list views use a new Web Part called the XsltListViewWebPart  which is list agnostic and provides AJAX enabled 
rendering. 

1.  If it is not open, launch SharePoint Designer 2010 and open the http://moss.contoso.com/sites/lab03 site.  

2.  On the New Toy Ideas list overview page, in the Views group open the All Items view by selecting it.  

3.  On the AllItems.aspx tab that appears, take note of the XsltListViewWebPart  on the page.  

 

4.  On the ribbon, in the View tab, choose Design in order to switch to the design view of the 
AllItems.aspx  page.  

5.  In the design view for the AllItems.aspx  page select the XsltListViewWebPart .  

6.  On the ribbon, in the Options tab choose Inline Editing to enable inline editing for the list.  

7.  On the ribbon in the Quick A ccess Toolbar, choose Save in order to save the page.  

8.  In the browser, navigate to the New Toys Ideas list in the http://moss.contoso.com/sites/lab03 site. Take 

note of the new inline -editing controls appearing on the AllItems.aspx  page.  
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9.  Inside the list vi ew, select the New  button displayed below the first list item. Use the following 

information as data for the new list item.  
Title:  Rocket - fueled Buggy  

Age Group:  3 to 6  

Required Investment:  Safe rocket boosters and non -exploding fuel  

Existing Product:  No 

Use the Save button displayed on the left -hand side of the new list item to save the item. Note the 

AJAX refresh of the page.   

10.  Select the list item that you have just added. On the left -hand side of the item choose the Edit 
icon. Change the Title of the ite m to Rocket-fueled buggy with support wheels.  

11.  Select the first list item in the list. On the ribbon in the Items tab choose Approve / Reject in order to 

approve the item. Perform the following tasks in the dialog that appears.  

a)  Select the Approved  option  

b)  Choose Ok to close the dialog.  

12.  Switch back to SharePoint Designer 2010 and keep the browser window open.  

13.  Ensure that the AllItems.aspx  page is open and the XsltListViewWebPart  is selected.  

14.  On the ribbon, in the Options tab, choose Sort & Group from the Filter, Sort & Group group in order to 
show the Sort and Group dialog.  

15.  In the Sort and Group dialog, perform the following tasks.  

a)  In the Sort order  list, remove the ID field.  

b)  In the list of available fields, select Age Group. 

c)  Choose Add to add the field to the  sort order  

d)  Choose Show group header to group items based on the Age Group field.  

e)  Choose OK to commit the changes.  

16.  Select the first data row in the list (specifically the <tr>  tag) to add conditional formatting. You 
will likely need to use the tag selector  to ensure you get the correct HTML element:  

 

On the r ibbon , in the Options tab expand Conditional Formatting, expand Apply Formatting and choose 
Apply to Row. 

17.  In the Condition Criteria dialog that appears perform the following tasks:  

a)  Add a new clause wit h the following values;  


